About the Tutorial

Analysis Edition for OLAP, the business intelligence reporting tool, is a part of SAP BusinessObjects product suite. This is a handy tool for business users for analytical and ad hoc reporting. Using this tool, business users can create basic, medium, and complex reports from transactional data available in OLAP data sources such as SAP BW and HANA to meet the business requirements. This tutorial explains the key concepts of SAP BO Analysis Edition for OLAP.

Audience

This tutorial is designed for all those readers who want to learn the basics of SAP BO Analysis Edition for OLAP and implement it to analyze data with the help of this tool.

Prerequisites

You need to have the required skills to unearth relevant data and analyze it in order to create professional Business Intelligence reports. You should have a basic understanding about OLAP data sources such as SAP Business Warehouse, HANA Modeling views, etc.

Disclaimer & Copyright

© Copyright 2018 by Tutorials Point (I) Pvt. Ltd.

All the content and graphics published in this e-book are the property of Tutorials Point (I) Pvt. Ltd. The user of this e-book is prohibited to reuse, retain, copy, distribute or republish any contents or a part of contents of this e-book in any manner without written consent of the publisher.

We strive to update the contents of our website and tutorials as timely and as precisely as possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt. Ltd. provides no guarantee regarding the accuracy, timeliness or completeness of our website or its contents including this tutorial. If you discover any errors on our website or in this tutorial, please notify us at contact@tutorialspoint.com.
# Table of Contents

About the Tutorial ............................................................................................................. i  
Audience .......................................................................................................................... i  
Prerequisites ..................................................................................................................... i  
Disclaimer & Copyright .................................................................................................... i  
Table of Contents ............................................................................................................... ii

1. **SAP BO ANALYSIS – OVERVIEW............................................................................. 1**  
   What is an OLAP Data Source? ....................................................................................... 2

2. **SAP BO ANALYSIS – USER INTERFACE ................................................................. 4**

3. **SAP BO ANALYSIS – CREATE A WORKSPACE...................................................... 7**  
   Adding Chart to WS ....................................................................................................... 9  
   Adding Crosstab to WS ................................................................................................. 10  
   How to Copy an Existing Crosstab or Chart? ............................................................... 11  
   Saving a Workspace ..................................................................................................... 12

4. **SAP BO ANALYSIS – ANALYSES............................................................................ 14**  
   Defining a New Analysis ............................................................................................... 14  
   Adding Analysis to a Worksheet ................................................................................. 16

5. **SAP BO ANALYSIS – CROSSTABS........................................................................ 17**  
   Adding a Crosstab ......................................................................................................... 17

6. **SAP BO ANALYSIS – CHARTS ............................................................................... 20**  
   Adding Data to a Chart ................................................................................................. 21  
   How to Change the Chart Type? .................................................................................. 23  
   Chart Properties ......................................................................................................... 24
7. **SAP BO ANALYSIS — CHART TYPES & STYLES** ................................................................. 26
   - Column Charts ........................................................................................................ 26
   - Bar charts ............................................................................................................. 26
   - Other Charts ........................................................................................................ 26
   - Displaying Totals ................................................................................................. 27
   - Chart Styles ......................................................................................................... 28

8. **SAP BO ANALYSIS — SUB-ANALYSIS** ...................................................................... 29
   - Pause and Unlink .................................................................................................. 30

9. **SAP BO ANALYSIS — USING FILTERS** ................................................................. 33
   - How to Edit an Existing Filter? ........................................................................... 35
   - How to Delete Filters in an Analysis? ................................................................. 36
   - Filter Types ......................................................................................................... 36
   - Background Filters ............................................................................................. 37

10. **SAP BO ANALYSIS — SORTING** ............................................................................ 39
    - How to Apply Sort in a Crosstab? ...................................................................... 39
    - How to Reverse a Sort Order? .......................................................................... 40
    - How to Remove a Sort Filter? ........................................................................... 41

11. **SAP BO ANALYSIS — CONDITIONAL FORMATTING** ........................................ 42

12. **SAP BO ANALYSIS — CALCULATIONS** .................................................................... 46
    - Create a Calculation Via Calculation Panel ...................................................... 47
    - SAP BO Analysis – Calculation With Sorts ..................................................... 49

13. **SAP BO ANALYSIS — AGGREGATIONS** .................................................................. 50

14. **SAP BO ANALYSIS — HIERARCHIES** ................................................................... 52
15. SAP BO ANALYSIS ─ SHEETS ................................................................................................................. 55
   How to Add a Sheet? ................................................................................................................................. 55
   How to Delete a Sheet? ........................................................................................................................ ..... 56
   How to Rename a Sheet? ......................................................................................................................... 56

16. SAP BO ANALYSIS ─ SHARING WORKSPACES ............................................................................... 57
   Sending a Workspace to Another User Via Email .................................................................................... 58

17. SAP BO ANALYSIS ─ EXPORT OPTIONS ......................................................................................... 60
   Exporting Data to an Excel .................................................................................................................... 61
   Exporting an Analysis to PDF ............................................................................................................... 63

18. SAP BO ANALYSIS ─ CONNECTING TO SAP BW ............................................................................. 64
Analysis edition for OLAP is a BI reporting tool using which you can connect to OLAP data sources. It helps business managers in decision making, and to analyze business data. You create a new workspace, then add charts and crosstab objects and OLAP data sources to get the data into these objects.

In Analysis edition for OLAP, you can connect to multiple data providers simultaneously. For example, you can have a workspace where data comes from SAP BW cube and also from Microsoft Analysis Cube.

This tool can be accessed via BI Launchpad in a web browser using the following link - http://localhost:8080/BOE/BI

In the above link, localhost represents the Name of BI server. When you have BI server on the same system on which you are trying to access BI Launchpad, you can use the local host in the URL, otherwise you have to mention the name of BI server to open BI Launchpad.

To open the application, navigate to Applications dropdown at the top of the screen. You can see Analysis Edition for OLAP tool in the dropdown list.
You should have tool installed on SAP BusinessObjects server and a connection from the local system to BI platform. You can also access SAP BO Analysis for Microsoft Office, which integrates Analysis with Microsoft Excel and PowerPoint.

All the connections and Analysis workspaces are managed in Central Management Console (CMC). You can distribute Analysis workspace to large number of users over the web.

What is an OLAP Data Source?

A relational data source contains data in one format and to meet the business requirements, you need to create a multidimensional product. OLAP data represents the hierarchical aggregations of the individual transactions. Aggregated data can be analyzed much faster than relational data.

OLAP data source also allows hierarchy of data where you can drill to different data levels. OLAP data model is also called a data cube.
Using a data cube, you can analyze the data in different ways to meet different business requirements. In the above cube, you can analyze -

- How are products selling at different times of year? (Product by Time)
- How are products selling in each region? (Product by Region)
- How are products selling in each region at different times? (Product by Region and Time)
When a new workspace is opened, you can see different icons and panels in the user interface. Analysis Edition for OALP tool can be opened via BI Launchpad.

When a new workspace is created, you have to select the data source. It shows you a list of all OLAP connections to different database. Once you select the connection, you will be prompted to select an OLAP model.

Following panels are available under the user interface -

- Task Panel
- Layout Panel
- Metadata Explorer
- Analysis Window
- Crosstab
- Chart
At the top, you have the task panel where you can perform different operations - Creating a new workspace, Open option, Save Option. You can even change an OLAP connection or remove a connection in the workspace.

On the left side you have a metadata explorer, where all the objects from OALP data source is displayed. You can see different measure and dimension values.

In the middle pane, you have the Layout option, which defines the layout of Crosstab. You have to drag different measures and dimensions to the corresponding columns and rows. You can use the Background option to filter the data in background based on Dimension values.
In the right pane, you have Analysis Panel, Crosstabs, and Chart. Crosstabs and Charts are based on the values selected in the Layout panel.

In the Analysis panel, you have 3 tabs -

- **Analyze** — Under the Analyze tab, you have an option to apply Filter and Sort.
- **Insert** — Under the Insert tab, you can add Crosstabs and insert different type of charts.
- **Display** — Under the Display tab, you can manipulate data under crosstab. You can swap axis, create sub-analysis, define nulls and zeros, etc.
To create a new workspace, you have to click the New button - Create a new workspace.

When you click the New button, you will be prompted to select a data source. You can select from the dropdown list to view all the connections or the connections pointing to Cube/InfoProvider or to Query/Query View to connect to BW OLAP source.

When you select “All” from the dropdown list, you can see -

- OLAP Connections
- Cube/InfoProvider
- Query/QueryView
Click the Next button and you will see a list of all the Modeling Views/InfoCubes in the source system that are pointed using this OLAP connection.

![Image of Open Data Source window]

Navigate to Folders tab at the top. You can also perform a search with the name of InfoCube/Modeling View in the source system.

Select InfoCube from the source system and click the OK button.
When you click the OK button, all the measures and dimension values will be added to metadata explorer under the new workspace. You can see the name of InfoCube/Modeling View under Data tab in the Task panel.

You can drag different measures and dimension values to the Layout panel to create a Crosstab and Chart in the Analysis pane.
Adding Chart to WS

To add a chart to workspace, you have to navigate to the Insert tab at the top. You have different chart options under Insert. When you have multiple analysis on the sheet, each chart points to a specific analysis in the workspace.

Adding Chart

In the analysis window, you have to select the component that you want the chart to be linked to. Navigate to Insert tab and select the Chart from the available charts.

This will add the chart as a sub-analysis, linked to the component that you selected. The added chart is placed below or to the right of the existing components on the sheet.

Following chart types are available under the Insert tab in the tool -

- Column Chart Family
- Multiline Chart
- Multi Pie Chart
- Bar Chart
- Other Chart
Adding Crosstab to WS

In Analysis Edition for OLAP, you can add a crosstab as Analysis or Sub-analysis. To add a crosstab as sub-analysis, navigate to the “Insert” tab at the top of the screen.

![Insert tab](image)

This adds a crosstab as a sub-analysis, linked to the component that you selected. The crosstab is added to the right or below an existing component.

When you add it as sub-analysis, it is based on the existing object in the workspace. When you add it as a new analysis, it adds a blank crosstab below or right of an existing object.
How to Copy an Existing Crosstab or Chart?

It is also possible to copy an existing crosstab or chart. To copy an object, you have to select the object by clicking the Analysis panel. Later, click the Copy button at the top.
When the object is copied, you can paste this to a new sheet. To paste the object, you can use the paste button at the top of the screen. You can also copy the object on the right or below an existing object.

If you want to delete the component, you can click the cross button on the top right corner of the object.
Saving a Workspace

You can also save the workspace to BI platform repository. You can choose to save your changes to the existing workspace, or to save the modified workspace as a new workspace in the repository.

In the next window, you have to select the folder where you want to save the Workspace. Enter the name of the Workspace and click the Save button.
Note: In Analysis Edition for OLAP, if a workspace is idle for several minutes, a copy of the workspace is automatically saved to your Favorites folder before the session is terminated.

When the session is returned before it is terminated, the auto-save cycle is reset, and the workspace is auto-saved again the next time your workspace becomes idle for several minutes.
End of ebook preview

If you liked what you saw...

Buy it from our store @ https://store.tutorialspoint.com